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WinSpell - Windows Spelling Supervisor

WinSpell is a spell checking supervisor for Microsoft Windows applications.    It can supervise 
your typing and check each word you type against its internal dictionaries of words known to
be correctly spelled.    WinSpell visibly and audibly alerts you to words not recognized.    This 
supervision can be turned on and off at your discretion without exiting the program.

WinSpell can also check the spelling of document files and text copied to the Windows 
Clipboard.

Using these three modes, WinSpell can spell check any Windows application, including 
Electronic Mail and spreadsheets, on which many presentations are dependent.    In addition,
WinSpell makes a special effort to ignore numerical data and data pertaining to currency.

WinSpell can also be used to check single words in its main dialog window.    Such lookups 
may contain wild card characters so WinSpell can fill in the blanks for you.



File menu commands

The File menu offers the following commands:

New Creates a new User Dictionary.
Open Opens an existing User Dictionary.
Merge Merges words from a text file into the active User Dictionary.
Save Saves an opened User Dictionary using the same file name.
Save As Saves an opened User Dictionary to a specified file name.
Exit Exits WinSpell.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Always On Top Keeps WinSpell on top of all windows at all times.



Monitor menu commands

The Window menu offers the following commands, which enable add and remove windows 
from WinSpell's real time keyboard spelling monitor:

Add Adds a windows to WinSpell's Keyboard Monitor
Remove Removes a window from WinSpell's Keyboard Monitor
Begin/End Macro Begins or Ends the creation of a Search and Replace macro.



Spelling menu commands

The View menu offers the following commands:

Last Typo... Spell checks last word detected as misspelled.
Lookup Box... Spell checks word typed here.
Clipboard... Spell checks the clipboard.
File... Spell checks a file.



Settings menu commands

The View menu offers the following commands:

Beep Toggles beep on and off.
Flash Toggles flash on and off.
Use Memory Changes speed of lookup.
Associations... Sets Application to Search and Replace associations.
Dictionaries... Sets the standard WinSpell dictionaries.
Characters... Sets the system wide shortcut hotkeys.
Sounds... Sets the sounds WinSpell uses to alert you.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



New command (File menu)

Use this command to create a new User Dictionary in WinSpell.    You can open an existing 
User Dictionary with the Open command.

If you have not opened a User Dictionary since starting WinSpell and you added words in any
WinSpell dialog box, WinSpell will consider this a new User Dictionary and will display the    
Save As dialog box so you can name the new User Dictionary.

Whenever you create a new user dictionary the current user dictionary in memory is 
replaced.    If you have added words to the user dictionary, WinSpell will ask if you want to 
save the additions to the current user dictionary.    If you don't save the current user 
dictionary, the words you have added during the current session will be lost and will be 
flagged as misspelled during future sessions with that dictionary.    If you decide to save the 
changes, WinSpell will present you with the standard Windows Save As dialog box from 
which you can save your dictionary.

Note:    When you create a new User Dictionary, the title bar of WinSpell will read "WinSpell -
Untitled."    This means that the current user dictionary has not been saved.    If you have 
loaded and/or saved the User Dictionary, the name will be displayed in the title bar.

WinSpell remembers which User Dictionary you are using when you close WinSpell and will 
always load it automatically when you run WinSpell.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

This command opens an existing User Dictionary.    You are allowed to open one user 
dictionary at a time.    If you decide that a different user dictionary would be better than the 
current one, use this command to open it.

When you open a User Dictionary, the title bar of WinSpell will change to include the name 
of the User Dictionary you have opened.    If you have loaded and/or saved the User 
Dictionary, the name will be displayed in the title bar.

WinSpell remembers which user dictionary you used last and will always load it 
automatically when you run WinSpell.

You can create new User Dictionaries with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension 
you select in the List Files of Type box.

List Files of Type
Select the type of file you want to open.    The type available will change depending 
on the context in which the dialog box was invoked.

Drives
Select the drive from which WinSpell should read the file that you want to open.

Directories
Select the directory from which WinSpell should read the file that you want to open.

Network...
If available, choose this button to connect to a network location, assigning it a new 
drive letter.



Merge command (File menu)

Use this command to merge words from a text file into the active User Dictionary.    The file 
the words must be:

1. A standard text file (ASCII..    WinspEdt (WinSpell's accessory editor) can create
and edit these.

2. Contain one word per line.

NOTE:    Merging words does not alter the dictionary files themselves. It only affects the User
Dictionary in memory.    If you want to save the User Dictionary with the new words, use the
Save command.

When merging words you are presented with the standard Windows File Open dialog box.    
Use this dialog to find the file containing the word list you wish to merge into the active User
Dictionary. To merge a word list into your active User Dictionary do the following:

1. From the WinSpell window, select File|Merge.
2. Choose and highlight the file from which you wish to merge the words and 

click on the OK button.

The words contained in the merge file will be inserted into the active User Dictionary as 
correctly-spelled words.

NOTE:    This is one way of loading 'multiple' dictionaries.    Simply Merge from as many word
list files as you need.    For convenience, you can also use NOTEPAD to combine lists of words
from several files.

Merged words remain in the active User Dictionary until you:

1. Exit WinSpell.
2. Ask WinSpell to Open an existing User Dictionary.
3. Create a New User Dictionary.

If any of these actions are chosen, WinSpell will notice that the dictionary was modified and 
ask if you want to save it.    If you want to make the additions permanent, save the current 
User Dictionary.

Note:    Merging words does not alter the dictionary files themselves.    It only affects the 
User Dictionary in memory.    If you want to save the User Dictionary with the new words, use
the Save command.



Save command (File menu)

Use this command to save the active User Dictionary.    When you choose this item, WinSpell 
saves the current User Dictionary immediately and without confirmation.

If you have not opened a User Dictionary since starting WinSpell and you added or merged 
words, WinSpell will consider this a new User Dictionary and will display the Save As dialog 
box so you can name the new User Dictionary.

If you want to change the name and directory of an existing User Dictionary before you save 
it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to name and save the active User Dictionary.    When you select this 
command, WinSpell displays the Save As dialog box so you can name your User Dictionary.

To save a User Dictionary with its existing name and directory, use the Save command.

The following options allow you to specify the name and location of the User Dictionary 
you're about to save:



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:

File Name
Type a new filename to save a User Dictionary with a different name.    A filename can
contain up to eight characters and an extension of up to three characters.    WinSpell 
adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store your User Dictionary.

Directories
Select the directory in which you want to store your User Dictionary.

Network...
This button allows you to connect to a network location and to assign it a new drive 
letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open one of the last 
four User Dictionaries you closed.    Choose the number that corresponds with the User 
Dictionary you want to open.



Exit command (File menu)

This command ends your WinSpell session (alternatively, you may use the Close command 
on the application Control menu).    WinSpell prompts you to save your User Dictionary if you 
changed it in any way.    If any windows are currently being monitored, WinSpell will detach 
its typing monitor from them.

Shortcut:
Mouse:Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in WinSpell.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the WinSpell's main window, below the menu bar.   
The Toolbar includes buttons for some of the most common commands in WinSpell, such as 
File Open.

A check mark appears next to the menu item when the Toolbar is displayed.    If you set this 
option to off, the toolbar will no longer be displayed in WinSpell's window.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new User Dictionary.

Open an existing User Dictionary.    WinSpell displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active User Dictionary or template with its current name.    If you have not 
named the User Dictionary, WinSpell displays the Save As dialog box.

Check the spelling of a document in a file.

Check the spelling of a document copied to the clipboard.

Toggles WinSpell's alert sounds on or off.

Toggles WinSpell's alert flash on or off.

Toggles WinSpell's ability to remain visible.

Lookups up Word to Check.

Lookups up templated Word to Check.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is located on the lowest line in the WinSpell window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The information in this line changes when you select menu choices or depress toolbar 
buttons.    The left area of the status bar describes actions of menu items as you use the 
arrow keys to navigate through menus, or push and hold the buttons in the toolbar.    If, after 
viewing the description of the item, you decide you don't want to execute the command, 
move the mouse pointer away from the item and release the mouse button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Always On Top command (View menu)

Use this command to tell WinSpell to force its window to the top of all windows.    A check 
mark appears next to the menu item when this option is On.    If you want to have WinSpell 
displayed on the screen no matter what else is running, set this item to On.

Shortcut:

Mouse:
Keys: CTRL+M



Add (Monitor Menu)

Use this command to tell WinSpell to begin monitoring your typing in a specific window.    If 
you choose the Monitor|Add menu item, WinSpell temporarily replaces the mouse cursor 
with a Check-Mark cursor.    Place the Check-Mark over the window you wish to have 
monitored and press the left mouse button.    The original cursor is replaced, and WinSpell 
adds the application running in the window to its list of monitored windows.    Click the right 
mouse button to cancel out of the Check-Mark cursor.

You can also add a window by using the system-wide Window Add hotkey.    Using this 
method simplifies your efforts since it does not require direct interaction with WinSpell.    
WinSpell determines in which window you pressed the hotkey and adds that window.

NOTE:    WinSpell automatically monitors your typing in any application which you associate 
with a Search and Replace macro.

NOTE:    You may add as many windows as you wish, however, WinSpell will not add itself to 
the Windows Desktop or DOS applications running in a window.

Shortcut:
Keys: CTRL+A
System Wide Hotkey:CTRL+ALT+=



Remove (Monitor Menu)

This command tells WinSpell to remove a window from its list of windows in which it is to 
monitoring your typing.    If you choose the Monitor|Remove menu item, WinSpell 
temporarily replaces the mouse cursor with a Check-Mark cursor.    Place the Check-Mark 
over the window from which you wish to remove monitoring and press the left mouse 
button.    The original cursor is replaced, and WinSpell removes its typing monitor from that 
window.    Click the right mouse button to cancel out of the Check-Mark cursor.

You can also remove a window by using the system-wide Remove Window hotkey.    Using 
this method simplifies your efforts since it does not require direct interaction with WinSpell.   
WinSpell determines in which window you pressed the hotkey and removes that window.

NOTE:    It is not necessary to remove a window before exiting either WinSpell or the 
application running in a monitored window.    WinSpell automatically removes itself from all 
windows if you exit WinSpell during a windows session.

Shortcut:
Keys: CTRL+R
System Wide Hotkey:CTRL+ALT+-



Begin/End Macro (Monitor Menu)

If you use an application for which WinSpell does not have a predefined Search and Replace 
macro, you can still get WinSpell to support it by creating the necessary macro.    The 
approach will vary somewhat, but the general process is as follows:

1. Make sure both WinSpell and the application for which you want to create a 
Search and Replace macro are running.

2. Set WinSpell to be Always On Top via WinSpell's Always On Top command.
3. Tell WinSpell you want to start recording a Search and Replace macro by 

selecting WinSpell's Monitor|Begin Marco menu item.
4. Using the mouse, activate the application    for which you want to create a 

macro by clicking on it.    You must use the mouse here because during macro 
creation, WinSpell remembers keystrokes and ignores mouse actions.    You 
don't actually want WinSpell to remember that you changed applications.    
Using the mouse is critical here, but the reason would take pages to explain.    
Just trust us and use the mouse.

5. Type, exactly, the keystrokes required to invoke your application's Search and 
Replace facility, placing the Correct and Incorrect words into the correct fields. 
WinSpell places the string Correct Incorrect into the clipboard prior to 
starting its macro recorder.    Place the Correct word in the Replace field and 
the Incorrect word in the Search (sometimes called Find) field.

6. Type the Keystroke which starts the actual Search and Replace.
7. Using the mouse, activate WinSpell by clicking on it and tell it to end this 

macro by selecting the Monitor|End Macro menu item.
8. Save the macro.    You specify the file name in which to save the macro using 

the File Save dialog box which WinSpell presents.

When you have completed the macro creation, select WinSpell's Settings|Associations 
menu item and associate the new macro file to your application.

The following shows you the steps used to create the Search and Replace macro for the 
Windows Write word processor.    You can practice with this example, but remember that you 
must follow, exactly, the procedure shown to get a properly functioning macro.    Remember,
though, that the following is only for Windows Write.    Other applications use somewhat 
different methods to do the same thing so consult your specific application's Users Guide to 
learn and understand its Search and replace function.

1.    Select WinSpell's Monitor|Begin menu.
Starts WinSpell's Search and Replace macro recorder.

2.    Click Mouse on Windows Write
Activates Windows Write so you can see the effects of the keystrokes as WinSpell 
records them.

3.    Esc
Quits whatever mode Write might be in.

4.    Ctrl-Home
Jumps to the beginning of the document.

5.    Alt-E
Opens the Find menu item for Windows Write.

6.    E
Invokes Write's Search and Replace Dialog box.

7.    Alt-N
Places the cursor in Find Field.    Do this whether the cursor is already there or not 
because later Write might do things a little differently.

8.    Shift-Ins



Inserts the clipboard into the Find: field.
9.    Ctrl-LeftArrow

Moves the cursor to the beginning of the Incorrect spelling.
10.    Shift-Home

Highlights the Correct spelling and the space between the Correct and Incorrect 
spelling.    You don't want to include the space in your search, it's just there for 
readability.

11.    Del
Deletes the highlighted text from the Find Field.    You are now set up to find the 
incorrectly spelled word.

12.    Alt-P
Places cursor in Replace Field.

10.    Shift-Ins
Inserts the clipboard into the Replace: field.

13.    Shift-Ctrl-LeftArrow
Highlights the Incorrect spelling.

14.    Shift-LeftArrow
Highlights the space between the Correct and Incorrect spelling.

15.    Del
Deletes the highlighted text from the Replace Field.    You are now set up to replace 
with the Correct spelling.

16.    Alt-F
Starts the actual Search and Replace Operation.

17.    Using Mouse, Select WinSpell's Monitor|End Macro menu item.
Ends Recording and Prompts to save it.

You may want to omit step 16 in your macros since that actually starts the Search and 
Replace process.    If you omit step 16, you allow yourself the option to edit the Replace field 
before starting.    WinSpell uses the misspelled word to generate the capitalization of the 
correctly spelled word before placing both in the clipboard.    There may be times when the 
capitalization is not what you wanted.    If you omit step 16, you simply start the actual 
Search and Replace yourself, after any editing of the Replace field.

If you make a mistake, or simply want to stop recording the macro, select WinSpell's 
Monitor|End Macro menu item.    WinSpell then asks you to save the macro.    At that point,
simply click the Cancel button of the Save As dialog box.    This tells WinSpell not to save the 
macro and you can start the macro creation process over as necessary.

After creating and saving a Search and Replace macro, use the Associations... command to 
associate the macro with the desired program.



Last Typo (Spelling Menu)

Use this command to tell WinSpell to recall and lookup the most recently typed word for 
Word Lookup dialog box display.    This works in any window WinSpell has been told to 
monitor via the Add menu item or the Window Add hotkey.

Shortcut:
Keys: CTRL+G
System Wide Hotkey:ALT+CTRL+/



Lookup Box (Spelling Menu)

Use this command to tell WinSpell to look up a word in the Word To Check: field.    When you 
select either of these items, WinSpell provides possible corrections to the word in the Word 
Lookup dialog box:

If you would like to have the word corrected in a document:

1. Highlight the correct spelling, or type the correction directly into the 
Correction: field.

2. Press the Correct button.    WinSpell temporarily replaces the mouse pointer 
with a    Check-Mark cursor.

3. Place the + (cross-hair) part of the cursor over the window that contains the 
document in which the misspelled word needs correction.

4. Click the left mouse button.

If the application running in the window on which you clicked has an associated Search and 
Replace macro, WinSpell loads and plays the associated Search and Replace macro to the 
chosen application.    When it does this, you will see WinSpell actually placing the incorrectly 
spelled word and the correctly spelled word into the corresponding fields of the Search and 
Replace dialog box in your application.    You then proceed as described by your application's 
instructions for completing the Search and Replace operation.

If the application running in the window on which you clicked does not have an associated 
Search and Replace macro, WinSpell will display a warning message and ask you to provide 
one by selecting a macro journal file.

Shortcut:

Mouse:
Keys: Enter



Lookup Crossword (Spelling Menu)

Use this command to look up a word for which you know some, but not all, of letters.    A 
good example would be to look up a word you just can't get on a crossword puzzle.    
Construct the Crossword Template by replacing each unknown letter with a question mark 
(?) character.

Enter the characters of a word that you know are correct, into the Word to Check:, and 
replace the rest of the characters with question marks (the crossword lookup character).    
When you use this option, WinSpell will match any words that meet your 'template' word.

Note that this is an exact length match.    WinSpell locates all correctly spelled words which 
fit the length and pattern of the wildcard word.    For instance, the templated word:

th?s

matches "this" and "thus" but not "these".

Shortcut:

Mouse:
Keys: Ctrl-Enter



Clipboard (Spelling Menu)

Use this command to tell WinSpell to check text previously copied to the Windows Clipboard. 
WinSpell will then present you with the WinSpell File Check Dialog box.

Shortcut:

Mouse:
System Wide Hotkey:ALT+CTRL+\



File (Spelling Menu)

Use this command to tell WinSpell to check the words in a Windows Write document or text 
file.    WinSpell will then present you with the WinSpell File Check Dialog box.

Shortcut:

Mouse:



File Document Checking Dialog Box

Given this dialog box, you specify a file to check and tell WinSpell to begin the actual check 
by pressing the Begin button.    If you don't know exactly where the file is, you may press the
Browse button which presents you with the File Open dialog box which you can use to locate 
and specify the file.

If you are spell checking the contents of the clipboard, both the File: field and Browse... 
button are disabled as they have no meaning in the clipboard.    However, the Clipboard 
Editor check box is enabled.    If checked, this instructs WinSpell to activate WinspEdt to use 
it for the Search and Replace operation if you request a correction via the Correct button.    
If you do use WinspEdt to perform the Search and Replace, remember to copy the corrected 
text back into the clipboard.    WinspEdt has a special smart icon (or menu item) just for that 
operation.

After pressing the Begin button, WinSpell starts its search for unknown words in the 
document.    As    WinSpell finds words, it places them into the Unknown Words: list box.    The
box next to the Unknown Words: list box (Occurrences:) shows how many times the 
misspelled word was used in the document.

When the spell check is complete WinSpell notifies you by beeping the computer speaker.    
You can then review the list to determine if you need to replace any words in your document.

When reviewing the list of words reported as misspelled, use the Lookup... button to get 
WinSpell to lookup at the correct spelling of the highlighted word.

If WinSpell reports any words that are actually spelled correctly, you may add them to the 
active User Dictionary by highlighting them and pressing the Add to Dictionary... button.    
Additionally, you can request that WinSpell correct any of the misspelled words by pressing 
the Correct button.    Pressing this button invokes the Word Lookup dialog box.

When you are done reviewing the misspellings, you quit the file check by pressing the Done 
button.



Beep (Settings Menu)

Use this command to tell WinSpell to Beep your computer's speaker when you misspell a 
word while typing.    If your computer can play Wave files, you can have WinSpell play a 
wave instead of the beep.    See Sounds Dialog box for more information about wave files.

Note:    WinSpell only Beeps when you type in windows you have asked it to monitor via the 
Add command, or in those applications listed in the Associations Dialog box.

A check mark appears next to the menu item when this option is turned On.

Shortcut:

Mouse:
Keys: CTRL+B



Flash (Settings Menu)

Use this command to tell WinSpell to Flash the Title Bar of the active window when you 
misspell a word while typing.    The active window is the window in which you were typing 
when WinSpell detected the misspelled word.

Note:    WinSpell only Flashes when you type in windows you have asked it to monitor via 
the Add command, or in those applications listed in the Associations Dialog box.

A check mark appears next to the menu item when this option is turned On.

Shortcut:

Mouse:
Keys: CTRL+F



Use Memory (Settings Menu)

WinSpell has two modes of operation with respect to memory usage.    The largest dictionary 
contains about 110,000 words.    This dictionary can be maintained (loaded) in memory if 
requested by turning on the Use Memory setting.

Use Memory increases the speed of word lookups.    If this setting is turned off the word 
lookups take place via the hard disk file.

The choice of whether or not to Use Memory should be based on your computer system.    If 
you are your computer system has less than 4 Megabytes of Random Access Memory (RAM) 
you should consider turning this setting off.

NOTE:    If USE MEMORY is on and there is not enough available memory, WinSpell will 
automatically operate as if the option were off.

A check mark appears next to the menu item when Use Memory is turned On. 

Shortcut:
Keys: CTRL+M



Associations (Settings Menu)

Use this command to manipulate associations between Applications and Search and Replace
macros.    WinSpell uses the associations to determine how to invoke global Search and 
Replace operations in your document processor.    This command presents you with the 
WinSpell Macro Associations dialog box.

WinSpell uses the Search and Replace feature of other applications to correct misspellings in
your documents.    For this to work, WinSpell uses associations between application names 
and macro journal files.

There are three basic pieces to this:

Topic Description
Macro Journal Files Files, in which prerecorded keystrokes are stored, which invoke 

and setup a Search and Replace feature.
Application Name The name of an application.    This is usually, but not 

necessarily, the name of the application's executable file.
Association Tells WinSpell which macro journal file belongs to which 

application.

Associating applications to Search and Replace macro journal files does two things:

1. Allows WinSpell to automate the task of correcting the spelling of any 
document created with the associated applications.

2. Tells WinSpell to monitor your typing whenever you are working in the 
associated applications.

NOTE:    If you have an application which does not have a general search and replace 
feature, but still want to have WinSpell automatically monitor your typing in the application, 
associate the application with the NO_MACRO.JNL file.    That is a file which does absolutely 
nothing.    However, since the application is associated with a macro journal file, WinSpell will
auto-attach to the application you run it.

To associate a Search and Replace macro journal file with one of your applications:

1. From WinSpell's Main Menu, select the Settings|Association menu item.    
The WinSpell Macro Associations dialog box will be displayed.

2. Press the New... button to get the Associate Macro dialog box.

To delete an association from the list, select the desired association by clicking the mouse on
it and then on the Delete button.    Remember that if you delete an association, WinSpell will 
not automatically attach its keyboard monitoring mechanism for the application anymore.

To edit an existing association, select the desired association and press the Edit button to 
display the Macro Associations dialog box.    From there you can change the settings by 
selecting the correct Application and/or Macro.



Macro Associations Dialog Box

This dialog box allows you to view, create, delete and edit Application to Search and Replace
Macro associations.    WinSpell uses these associations to provide automated global Search 
and Replace in your documents when you request that WinSpell correct a document.    This is
usually done during a File Check or Clipboard Check.

To associate an application with a Search and Replace macro press the New... button.

To delete an association from the list, select the desired association and press the Delete 
button.

To Change an existing association press the Edit button.



Associate Macro Dialog box

The Associations Dialog box contains two edit fields:

Application:
Specify the application in which you want WinSpell to be able to automatically correct
your spelling mistakes.    There are four methods by which you can select the 
application:
Press the Combo Box drop-down button (the arrow pointing down) to view a list of 

applications for which WinSpell already has support.    When you select the application, 
WinSpell will fill in appropriate values for the Application: and Macro: fields for you.

Press the Browse... button next to the Application field to invoke a File Open dialog 
box.    Use this dialog box to select the executable file of the application.

Press the Window button.    The mouse pointer will be replaced by a Check Mark 
cursor.    Using the mouse, place the cursor over the desired application and click the left 
mouse button.    WinSpell determines the correct name for the application and fills in the 
Application: field appropriately.    WinSpell may fill in the Macro field if it can find a macro file 
which belongs to the application. Click the right mouse button to cancel out of the Check-
Mark cursor.

Type the application's module name in the Application field.    This is the most 
inaccurate case, since some applications chain their execution.    This means the actual 
application running while you work in the application is not what you actually start the 
application with.    For Instance, Lotus' Ami Pro is started from the AMIPRO.EXE executable, 
but that executable just does some work, then chains to AMIPROUI.EXE.    Thus, when you 
are working in AMIPRO, you are really working in AMIPROUI.EXE.    AMIPROUI is the only part 
in which WinSpell is interested.

Macro:
This field specifies the fully qualified path to the macro journal file containing 
prerecorded keystrokes which invoke the Search and Replace features of your 
document processor.    The macro file can be created using WinSpell's Begin Macro
command.    For instance, under the default installation of WinSpell, the Windows 
Write Journal file can be specified as:

C:\WINSPELL\WRITE.JNL

There are three ways to do this:

Press the Browse button next to the Macro field to invoke a File Open dialog box.    
Use this dialog box to select the desired file.

Press the Default button.    If there is an application listed in the Application field, but 
no macro, WinSpell will attempt to locate a viable macro for the application.    This is not 
always successful, but may provide the correct results

Type the full path to the desired macro file.    For instance, C:\WINSPELL\WINSPEDT.JNL
for WinspEdt.



Dictionaries (Settings Menu)

Use this command to change from the standard WinSpell dictionaries to other optional 
dictionaries.    This command presents you with the Dictionaries Dialog box.



Word Lookup Dialog Box

There are four methods to get WinSpell to lookup a word:

1. Choose the Spelling/Last Typo... command.
2. Press the system wide Lookup Hotkey combination.
3. Press the Lookup... button in the File Check dialog box.
4 Choose the Spelling/Lookup Box... command.

When WinSpell is asked to lookup the correct spelling of a word via any of these methods it 
presents the user with plausible guesses in the form of a dialog dox.

The Word Lookup dialog box shows the word WinSpell is looking up in the upper left.    Below 
the lookup word is a list box which shows WinSpell's guesses.

In addition the following buttons are displayed:

Add To Dictionary Adds the word, for which the lookup supplied, to the active User
Dictionary.

Correct Replaces the misspelled word with the highlighted word.
Guess Harder Tells WinSpell to guess harder if possible.    This may present 

more guesses at the correct spelling of the word.
-> Clipboard Sends the highlighted word in the Unknown Words List box to 

the clipboard and exits the dialog box.
Cancel Removes the Dialog box with no other action.
Help Invokes this help information.



Dictionaries Dialog box

The Dictionaries Dialog box contains two edit fields:

Common: This dictionary consists of many of the most commonly used words in 
general document processing.    It is not large, but represents 80-90% 
of the most commonly used words in the language.    This dictionary is 
called COMMON.DCT by default.

Full: This dictionary is the main dictionary which contains all words known 
to WinSpell which are not in your User Dictionaries.    This dictionary is 
called FULL.DCT by default.

Be sure to type the full path and filename into the desired edit area.    If you don't know the 
full path, press the Browse button next to the desired dictionary to invoke a File Open dialog 
box for browsing your disks.

Change dictionary paths only if you decide to change the standard WinSpell dictionaries or if
you copy WinSpell to another directory after installation.

Note:    COMMON.DCT and FULL.DCT are not related to the User Dictionary.    To use a 
different, or create a new User Dictionary, use Open or New commands.

The Dictionaries Dialog box is an advanced option settings tool.



Characters (Settings Menu)

Use this command to change the standard WinSpell hotkeys combinations and the 
Crossword Template Wildcard character.    This command presents you with the WinSpell 
Characters dialog box.



WinSpell Characters Dialog box

The WinSpell Characters Dialog box contains five edit fields.    Each field should contain one 
character, which when pressed while holding the Ctrl and Alt keys down invokes the desired 
action.

Lookup:
Invokes the Word Lookup dialog box with the most recently, fully typed word if 

pressed in a monitored window.    This works only in monitored windows.

Suspend:
Turns off on-line keyboard monitoring in the active window.    Same as Remove 

Window command.    This works only in monitored windows.

Restart:
Resumes on-line keyboard monitoring in the active window.    Same as Add Window 

command.    This works only in any window.

Clipboard:
Invokes the File Check dialog box on the clipboard.    This works in any window.

Crossword:
Specifies the character WinSpell should use as the wildcard character in crossword 

lookups.



Sounds (Settings Menu)

Use this command to select the sounds you hear when you misspell a word while typing in a 
monitored window.

WinSpell's default audio makes a single Beep on your computer's speaker when you misspell
a word, and two Beeps when you repeat a word while typing.

This command presents you with the Sounds Dialog box.



Sounds Dialog box

The Sounds Dialog box contains two edit fields:

Beep:
This field specifies the full path to the Wave File WinSpell is to play when you misspell
a word while typing in a monitored window.

Repeat:
This field specifies the full path to the Wave File WinSpell is to play when you repeat a

correctly spelled word while typing in a monitored window.

NOTE:    Remember to type the full path and filename into the desired edit area.    If you 
don't know the full path, press the Browse button next to the desired field to invoke a File 
Open dialog box to facilitate finding the correct files.



Index command (Help menu)

Use this command to display the opening screen of WinSpell's on-line help.    From there you 
can jump to step-by-step instructions for using WinSpell and various types of reference 
information.

NOTE:    For context sensitive help based on your current location in WinSpell, press F1.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command to display help on using the Windows Help System. 



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
WinSpell.    If you call for technical support, this screen is necessary to know which version of
WinSpell you are running.



Context Help command 

Use the Context Help command to obtain help on some portion of WinSpell.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the WinSpell window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut:
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and active User Dictionary.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:

Application Control-menu button

User Dictionary Control-menu button

Maximize button

Minimize button

Name of the application

Name of the User Dictionary

Restore button



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move 
the pointer to the border you want to move.    

2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut:
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut:
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the WinSpell window to an icon.

Shortcut:

Mouse:Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut:

Mouse:Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a User Dictionary window.



Close command (Control menus)

Use this command to close down (exit) WinSpell.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts:
Keys: ALT+F4



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut:
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This 
option does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 

affect applications reduced to icons.
Arrange Icons

Arranges the icons of all minimized applications across the bottom of the screen.



Hotkeys

WinSpell provides system wide hotkeys for various functions to make them available even 
when WinSpell is not the active application.

To use the hotkeys, press and hold    Ctrl, Alt keys while pressing the hotkey character.    For 
instance, to press the Lookup Hotkey, press Ctrl+Alt+?.



Macro

WinSpell uses macro journal files which contain prerecorded keystrokes to invoke the Search 
and Replace features of Windows Applications.    These macros automate the task of 
replacing misspelled words from a File or Clipboard spell check.



Correcting Misspellings

WinSpell automates the actions required to correct misspellings of words through macros.

Whenever you press a Correct button in any of the dialog boxes in which it is available, 
WinSpell will invoke a macro of the type most useful the current operation.    For instance, if 
you are typing and invoke the Word Lookup dialog box to lookup the correct spelling of the 
last typo, WinSpell will generate and play a macro which will correct the word as if you 
backspaced and retyped the correction yourself.

If the correction was requested during a File Check operation, WinSpell will request that you 
choose a window in which to play a Search and Replace macro.    In this mode, WinSpell 
temporarily replaces the cursor with a Check Mark Cursor.    Place the check over the window
in which you want WinSpell to invoke the Search and Replace operation and click the left 
mouse button. Click the right mouse button to cancel out of the Check-Mark cursor.

WinSpell will attempt to associate the application running in the chosen window with a 
journal file of prerecorded keystrokes.    If WinSpell successfully associates the window with a
macro, it loads and plays the macro to invoke the Global Search and Replace on the 
document thus automating document correction of misspelled words.

You can create your own macros for applications not directly supported by WinSpell using 
the Begin Macro command.

NOTE:    If you have an application which does not have a general search and replace 
feature, but still want to WinSpell automatically monitor your typing in that application, 
associate the application with the NO_MACRO.JNL file.    That is a special file which does 
nothing as a macro, but since your application is associated with a macro journal file, 
WinSpell will auto-attach to it when it is run.

NOTE:    If you have an application which does not have a general search and replace 
feature but want to do corrections on documents in the application, copy the text from the 
application to the clipboard and tell WinSpell to spell check the clipboard.    From there, you 
can correct the text in the clipboard using WinspEdt - WinSpells Accessory Editor which has a
Search and Replace feature.    See the Clipboard Check command for more information.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




